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MEETINGS are held on 
the third Wednesday of 

the Month, at  
Christ Church 

O’Halloran Hill 1708 
Main South Road 
O’Halloran Hill at 

7.30pm 
Visitors most welcome.  
Cost $2 per person, which 

includes the Newsletter 
plus coffee/tea and 

biscuits. 
Subscriptions for twelve 

months Single $18 
Family membership $24 
Novice and experienced 
computer users will be 

warmly welcomed  

SOUTHERN DISTRICTS COMPUTER 

USERS CLUB INC.  

 July 2009 

Southern Districts 
Computer Users Club 

Inc. 
For further information 

about S.D.C.U.C.Inc. 

 

Contact The Club President,  
Jim Greenfield 83824912 

 
Correspondence to 

The Secretary 
S.D.C.U.C.I. 

Box 991 
Morphett Vale  5162 

Email to 

ronald.stephens1@three.com.au 

Club Web Site    http://videocam.net.au/sdcuci/indexhtml 
Editor Jim Greenfield 

 
Joan Jones                    9th July 
 
Val Greenfield             9th July 

On this Day 

July 15th 1995 
Online retailer Amazon.com opened for business 

 

 

Help !!!!!! 
I have done something to my Computer , now it will not work properly. 

Can you fix it?   

Every time you download or install a new game, application, or software update, you 
make changes to your computer. Sometimes that change may make your system 
unstable. 

Have you ever wanted to go back to the way it was? With System Restore, you 

can. 

System Restore works a lot like the Undo command in Microsoft Word. You can use 
System Restore to remove any system changes that were made since the last time you 
remember your computer was working correctly. System Restore does not affect your 
personal data files (such as Microsoft Word documents, browsing history, drawings, 
favorites, or email) so you won't lose changes made to these files. 

How does System restore work? 

Windows XP periodically records a snapshot of your computer. These snapshots 

are called restore points. Windows XP also creates restore points at the time of 

significant system events (such as when an application or driver is installed) or 

you can create and name your own restore points at any time. If you have 

installed a program that has made your computer unstable, you can open system 

restore, choose a restore point, and return your computer to its previous stable 

state. 

When you run System Restore, a calendar is displayed to help you find restore 

points. If you don't use your computer every day, some days might not have any 

restore points. If you use your computer frequently, you might have restore points 

almost every day, and some days might have several restore points. 

Use System Restore to undo changes you have made to your computer 

Before you open the System Restore console, you may want to save your work 

and close all programs since System Restore requires you to restart your 

computer. 

Follow the instructions on the wizard. 

Through the All Programs menu:. 

Click Start. 
 

Point to All Programs. 
 

Point to Accessories. 
 

Point to System Tools. 
 

Click System Restore. 

 

Follow the instructions on the wizard. 

Creating a restore point can be useful any time you anticipate making changes to your 
computer that are risky or might make your computer unstable. If something goes 
wrong, you select the restore point you just created and Windows XP undoes any system 
changes made since that time. 
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OUTLOOK EXPRESS,  

Security and housekeeping tips 
 
 

Preview Pane: if you use the default setting that includes the preview pane under the messages list in 
your Inbox, there is a risk of some virus or Spyware infection. Turn it off: 

• Open Outlook Express, (offline ok) 

• Left click on the “View” tab above the toolbar 

• From the drop-down menu, choose “Layout” 

• On the Layout Panel, untick the box “show preview pane” 

• Click on the “Apply” button and then OK 
Close Layout panel, preview message will not be downloaded and displayed next time you access your 
mail inbox. 
 
When the preview pane is open, the mail message has to be opened. Some viruses or Spyware can 
exploit this feature. 
 
Deleted Items: When you clean up your Inbox and other folders, you use the “Delete” Button on the 
toolbar, (red cross). This action simply transfers the mail into the “Deleted Items” folder. Unless you 
empty this folder on a regular basis, the files will still be there taking up drive space. You can set 
Outlook Express to automatically delete these files on exiting the program: 

Open Outlook Express, 
Left click the “Tools” tab above the toolbar 
On the drop-down menu, select “Option” right at the bottom 
From the Options Panel, choose the “maintenance” tab 
On the “Cleaning up messages” panel, tick the box against “Empty Messages from ‘Deleted Items 

Folder” on exit” 

Note the other options for future reference. 
Click “OK” and the files will now be deleted when you exit Outlook Express.  

 
This feature will permanently delete the messages so be sure before you send any mail to the “deleted 
items” folder. 
 
Receipts: Outlook can be set up to ask for a receipt to be sent from a recipients PC. You might also get 
messages that ask for a receipt too. To control this function: 

• Open Outlook Express 

• Left click the “tools” tab and again select “Options” at the bottom of the drop-down menu 

• Select the “Receipts” tab 
Choose the option that you would like from the panel. Tick the box to request a receipt or untick not to 
request. Select the referred Radio Button at the lower pane to decide how you deal with receipt requests. 
I prefer the “Notify Me….” Option. Again, click on “Apply” and “OK” to finish. 

 
While you have the “Options” menu open, have a look under the other tabs for Security, 
Connections, and Signatures etc; to learn a little more about Outlook Express. 
 
Colin Campbell, July 09 
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Opinions expressed in this newsletter do not necessarily represent those of the Southern Districts Computer Users Club Inc. nor 
does publication of an advertisement imply endorsement by the Southern Districts Computer Users Club Inc.  
 

While every attempt has been made to verify that the information in this newsletter is correct, the Southern Districts Computer 
Users Club Inc accept no responsibility for any inaccuracies. 

 
Likewise no member of the committee or member of the Southern Districts Computer Users Club will accept any liability for any 
damage occurring to a computer,  to any computer system and/or data from following instructions given in this newsletter. 

  

Let Evacom  Fix  it  Professionally 
Minimum charge applies 

FOR UP MARKET & UPGRADEABLE 

COMPUTERS, 

PROFESSIONAL REPAIRS AND UP-GRADES 

AT SENSIBLE PRICES 

———————!! Go To !!——————- 

What is an UPS ? 

An uninterruptible power supply (UPS), also known as a battery back-up, provides emergency power 
and, depending on the topology, line regulation as well to connected equipment by supplying power from 
a separate source when utility power is not available. It differs from an auxiliary or emergency power 
system or standby generator, which does not provide instant protection from a momentary power 
interruption. A UPS, however, can be used to provide uninterrupted power to equipment, typically for 5–
15 minutes until an auxiliary power supply can be turned on, utility power restored, or equipment safely 
shut down. 

While not limited to safeguarding any particular type of equipment, a UPS is typically used to protect 
computers, data centers, telecommunication equipment or other electrical equipment where an 
unexpected power disruption could cause injuries, fatalities, serious business disruption or data loss. UPS 
units come in sizes ranging from units which will back up a single computer without monitor (around 200 
VA) to units which will power entire data centers or buildings (several megawatts). 
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VoIP, A Cheaper Phone System 

VoIP got a mention at one of our recent meetings, I thought that a short rundown on what it is would be 
useful for those of you who still subscribe to the Plain Old Telephone and continue to pay big 
TELSTRA bills. The following is an extract from a Government Communications information site, 
(http://www.accc.gov.au/content/index.phtml/itemId/815399). (Why reinvent the wheel?) 
 

What is VoIP? 

VoIP (Voice over Internet Protocol) is a relatively new technology that allows you to use your 

computer’s network connection as a telephone service. 

VoIP technology is growing in popularity. Calls using this technology are cheaper than those on 

the normal phone network, particularly for long distance and international numbers. As 

broadband Internet access becomes more widespread, VoIP is also becoming an increasingly 

easy and convenient way to communicate. 

You need a computer to use almost all VoIP services. Some may require special software and 

equipment, such as microphones.  

Some services may offer features such as conference and video calls, but might not be able to 

offer some traditional phone services.   

 
So, VoIP is an incredibly useful tool to add to your PC infrastructure. Fist though, some advice. VoIP 
works best with higher speed broadband. Wireless broadband is not that successful due to fluctuations 
in the typical (eg Next G) Wireless Broadband service. Dial-up? Forget it! 
So, if you have a good ADSL or ADSL2 Broadband, you aught to consider getting the phone addition.  
To use VoIP, you need to subscribe with one of the dozens of VoIP providers; Google for these in 
Australia and you will find quite a list. I use MyNetFone, just one of many, (www. mynetfone.com.au) 
for my provision of calls. Typical costs are as low as 100-national/local calls a month for just $9.95 per 
month. International calls are as low as 2.9 cents/minute to the UK with no flag-fall or time limits. 
Mobile calls are just 20c, again, no flag-fall. 9Better, no contracts!) 
Most providers require that you have an Analogue-to-Analogue (ATA) adapter to connect to your 
broadband modem and most telephone handsets will work plugged into the device. Best of all, unlike 
Skype application, you don’t have to have the PC on to use the system, just the modem connected. 
Seeing as you probably have the modem on all the time anyway, you will be connected. 
Broadband download usage is small, about 60kb/ talk-minute someone worked out; you can use the 
phone and the Internet at the same time. With the system from MyNetFone, you can get a DID number, 
(telephone number) for calls  
 
So, have a look at the prospect of using VoIP, we will have a demonstration one night soon. 
 
Colin Campbell, July 09 
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Automotive Repairs 

 
ALL GENERAL  

MECHANICAL REPAIRS 
Brakes, Suspension, Clutch, 

Auto Trans Service, 
Wheel Balance & Repairs, 

New & S/Hand Tyres. 
SERVICE, TUNE & SAFETY CHECK 
(most 4 & 6 cyl. cars) - Includes plugs, 

points, oil, filter. 
 

U4/2 Somerset Circuit 
Lonsdale S.A. 5160 

� 8186 0081 

Pensioner 

& Seniors 

Discount 

 MEETING RULES 

 

NO SMOKING    NO DRINKING   NO SWEARING 
 

We are allowed to use the facilities at Christ Church, O’Halloran Hill in return of a small fee plus respect for their property. We 
ask for your co-operation in respect to the above. While we can not control what our members do away from our club meetings, 

Piracy of copyright material can not be condoned at our meetings. 

Have you recently acquired, or do you just want to learn more about  
operating, your computer? 

The Club conducts classes on a wide range of subjects, at a very moderate charge. 

The maximum number in class is five.  

(Our aim is to conduct the classes in a friendly non-threatening atmosphere) 

Some of the classes that are available:- 

1. Basic Computing (Stage One and / or Stage Two) 

2. Advanced Word 

3. Internet workshops 

4. Digital Cameras 

For more information contact a committee member. 

South Australia History 
   1902  
Breaker Morant and Peter Hancock executed 
on 27 February.  
   1903  
First crematorium in Australia opened at 
West Terrace.  
RAA formed on 30 September 
   1904  
First community-run hotel in the British 
Empire established at Renmark.  
School opened at Innamincka.  
South Australia first State to make road laws 
for cars. They must carry a disc with name 
of owner and make of car. 
   1905  
 
First Kindergarten in South Australia 
opened.  
John Rymill, farmer and polar explorer, 
born. 
   1906  
One third of all hotels in Port Adelaide lost 
their liquor licence.  
First driving licence issued in Adelaide, an 
Australian first, to Dr William Hargreaves.  
Uranium discovered at Radium Hill by 
Arthur Smith. 
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E-Tax, a new way of doing things. 
 

It’s that time of year again and most of us are busy thinking of how we can get all our tax 
back from the government coffers. If you have been paid an income, via wages, super 
scheme income stream and/or Interest, the Government might be looking to get something 
from you. If you have to fill in a tax return, have you considered E-Tax? 
 
E-Tax is an electronic methodology of doing your tax return via your PC and the Internet. 
It is a self-guided and simple process providing that you have all of the usual information 
that the old forms needed. Also, I think that it is so simple I don’t understand why people 
with everyday incomes pay someone else to do their returns. 
 
First, to use E-Tax, you need a basic PC to run the free software, MAC will not work 
without Windows emulation.. Go to the Australian Taxation web site, look for E-Tax and 
view the system requirements. (http://www.ato.gov.au/) on this page there is a link to the 
site for the programme and a description of system requirements, some jargon and 
assurances that if you use E-Tax, and if you make mistakes, the ATO will not penalise you 
for getting it wrong, (not declaring income? Maybe not!) 
 
You will need to download the 2009 version of E-Tax, last years version is closed off and 
will not be suitable. 2009 version is up-to-date. You will also need a recent (2008) tax 
assessment notice for verification. You can view your tax return in the electronic format 
or the traditional layout for printing. Business returns are easy for small business earning/
losses. All worksheets are there for helping to calculate net earnings and the worksheets 
don’t get sent to the tax office. 
A good thing about the E-Tax form is that you can view a summary of your return and an 
estimated tax return/payment before submitting it. You can test affects of claiming 
deductions and earnings before sending too if you have any queries. There are links to a 
great Help file built in, information about all aspects of the return and most useful, built in 
calculators. In my experience, E-Tax returns are paid very quick and to the cent of what 
the tax summary tells you. 
 
If anyone would like to try E-Tax for the first time, here is an offer of free help as long as 
you realise that it will entail some personal data being viewed. Confidentiality assured 
though. 
 
Colin Campbell, July 09 
 

 

 

Want to know what is going on around SA, Nationally? planning a trip? Want 
to miss big events in a city/location to visit? Then have a look at this link to 
the ABC, the Big Diary, with a good search engine.  

 

http://www.abc.net.au/thebigdiary/default.htm 
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SPICY APPLE CRUNCH 

 
A DELICIOUS WINTER DESSERT 

 
INGREDIENTS 

 

1 Large can of Pie Apple or home cooked apples 

1 teaspoon powdered ginger 

½ cup sultanas 

¼ cup sugar 

1 cup rolled oats 

90g  melted butter or marg. 

½ cup coconut 

¼ cup chopped walnuts 

½ cup brown sugar 

1 teaspoon cinnamon or nutmeg (or allspice) 

Extra 1 teaspoon  powdered ginger 

 

METHOD 
 
COMBINE the pie apple, ginger, sultanas and sugar in a bowl and place in a greased 
ovenproof dish.  
MIX the rolled oats, melted butter, coconut, walnuts, brown sugar, cinnamon and 
ginger together and sprinkle over the top. 
BAKE in a mod oven  for 15 – 20 minutes. 
SERVE warm with custard or cream 
 
From the Editor. This recipe from Kay Martin  

I hope Kay supplies this at our next committee meeting!! 

CMOS Battery 

 
The memory and real-time clock are generally powered by a CR2032 lithium coin cell. These 
cells last two to ten years, depending on the type of motherboard, ambient temperature and the 
time that the system is powered off, while other common cell types can last significantly 
longer or shorter periods, such as the CR2016 which will generally last about 40% as long. 
Higher temperatures and longer power-off time will shorten cell life. When replacing the cell, 
the system time and CMOS BIOS settings may revert to default values. This may be avoided 
by replacing the cell with the power supply master switch on. On ATX motherboards, this will 
supply 5V standby power to the motherboard even if it is apparently "switched off", and keep 
the CMOS memory energised. 
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Your Notes 

 

 

 

 

 
Established 1991 

 

����    0422 912 583 

Web Design               Hosting             Domain Names 
 

Personalised Service 

http://vcsweb.com 
eBay Sales  

We have great items for gifts such as Playstation & Gameboy accessories, phone covers,  
wheat bags, laser pointers, chess sets and more. 

Buy online and pick up locally! 

http://www.stores.ebay.com.au/vcswebgoodiesbox/ 

 

We can also sell items for you.   

Contact us for details! 


